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Workshop Overview

q

9:00 Marcoscope Design and Usage & CIShell Powered Tools
9:15 Sci2 Tool Basics
»  Download and run the tool.

9:30 Sci2 Workflow Design: Padgett's Florentine Families - Prepare, load, analyze,
and visualize family and business networks from 15th century Florence.

10:00 Sci2 Tool — Using Text and Database Support

%

Studying Four Major NetSci Researchers.

»  Load and clean a dataset as text file or using the Sci2 Database; process raw
data into networks.

»  Find basic statistics and run various algorithms over the network.

> Visualize the networks as either a graph or a circular hierarchy.

10:15-10:30 Break

10:30-11:00 Sci2 Research Demonstration I: Indiana Philosophy Ontology Project -
Map concepts and influence in the field of philosophy.

11:00-11:30 Sci2 Research Demonstration II: The Letters of Athanasius Kircher.

11:30-12:00 Q&A and Technical Assistance
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10:00 Sci2 Tool — Using Text and Database Support
»  Studying Four Major NetSci Researchers.

» Load and clean a dataset as text file or using the Sci2 Database; process raw
data into networks.
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Map concepts and influence in the field of philosophy.
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11:30-12:00 Q&A and Technical Assistance

The Changing Scientific Landscape

Star Scientist -> Research Teams: In former times, science was driven by key scientists.
Today, science is driven by effectively collaborating co-author teams often comprising
expertise from multiple disciplines and several geospatial locations (Borner, Dall' Asta,
Ke, & Vespignani, 2005; Shneiderman, 2008).

Users -> Contributors: Web 2.0 technologies empower anybody to contribute to
Wikipedia or to exchange images and videos via Fickr and YouTube. WikiSpecies,
WikiProfessionals, or WikiProteins combine wiki and semantic technology in support
of real time community annotation of scientific datasets (Mons et al., 2008).

Cross-disciplinary: The best tools frequently borrow and synergistically combine
methods and techniques from different disciplines of science and empower
interdisciplinary and/or international teams of researchers, practitioners, or educators
to fine-tune and interpret results collectively.

One Specimen -> Data Streams: Microscopes and telescopes were originally used to
study one specimen at a time. Today, many researchers must make sense of massive
streams of multiple types of data with different formats, dynamics, and origin.

Static Instrument -> Evolving Cyberinfrastructure (CI): The importance of hardware
instruments that are rather static and expensive decreases relative to software
infrastructures that are highly flexible and continuously evolving according to the
needs of different sciences. Some of the most successtul services and tools are
decentralized increasing scalability and fault tolerance.




Just as the microscope empowered our naked eyes to see cells, microbes, and viruses
thereby advancing the progress of biology and medicine or the telescope opened our
minds to the immensity of the cosmos and has prepared mankind for the conquest of
space, macroscopes promise to help us cope with another infinite: the infinitely complex.
Macroscopes give us a ‘vision of the whole’ and help us “synthesize’. They let us detect
patterns, trends, outliers, and access details in the landscape of science. Instead of making
things larger or smaller, macroscopes let us observe what is at once too great, too slow, or
too complex for our eyes.

Desirable Features of Macroscopes

Core Architecture & Plugins/Division of Labor: Computer scientists need to design
the standardized, modular, easy to maintain and extend “core architecture”. Dataset
and algorithm plugins, i.e., the “filling”, are provided by those that care and know
most about the data and developed the algorithms: the domain experts.

Ease of Use: As most plugin contributions and usage will come from non-computer
scientists it must be possible to contribute, share, and use new plugins without writing
one line of code. Users need guidance for constructing effective workflows from 100+
continuously changing plugins.

Modularity: The design of software modules with well defined functionality that can be
flexibly combined helps reduce costs, makes it possible to have many contribute, and
increases flexibility in tool development, augmentation, and customization.

Standardization: Adoption of (industry) standards speeds up development as existing
code can be leveraged. It helps pool resources, supports interoperability, but also eases
the migration from research code to production code and hence the transfer of
research results into industry applications and products.

Open Data and Open Code: Lets anybody check, improve, or repurpose code and eases
the replication of scientific studies.

Macroscopes are similar to Flickr and YouTube and but instead of sharing images
or videos, you freely share datasets and algorithms with scholars around the globe.

Bérner, Katy (in press) Plug-and-Play Macroscopes. Communications of the ACM.




f!'ﬁ*ﬁ

A

£ b
3 . - Macroscope Design
14__“‘..“!‘{“.#.
Custom Tools for Different Scientific Communities

6 ¢ o Information Visualization Cyberinfrastructure
L] S
uf http://iv.slis.indiana.edu
_'i =% Network Workbench Tool + Community Wiki

http://nwb.slis.indiana.edu
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180+ Algorithm Plugins and Branded GUIs
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Core Architecture

Open Services Gateway Initiative (OSGi) Framework.

http://orgi.org
Cyberinfrastructure Shell (CIShell)

http://cishell.org

— osGi gl

Alliance

CIShell Powered Tools:
Network Workbench (NWB)




Network Workbench Tool
http: '

nwhb.slis.indiana. NWE Downloads Cummulative

Oct. 2008-Feb. 2010

70,000 4

The Network Workbench (NWB) tool
supports researchers, educators, and
practitioners interested in the study of
biomedical, social and behavioral science,
physics, and other networks.

In February 2009, the tool provides more 169
plugins that support the preprocessing,
analysis, modeling, and visualization of

networks.

More than 50 of these plugins can be
applied or were specifically designed for

S&T studies.

It has been downloaded more than 65,000
times since December 2006.
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Birner, Katy, Huang, Weixia (Bonnie), Linnemeier, Micah, Duhon, Russell |ackson, Phillips, Patrick, Ma, Nianli, Zoss, Angela, Guo,
Hanning & Price, Mark. (2010). Rete-Netzwerk-Red: Analyzing and Visualizing Scholarly Networks Using the Network Workbench Tool.
Scientometrics. 1'ol. 83(3), 863-876.
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Investigators:

Software Team:

Goal:

Amount:
Duration:
Website:

Katy Borner, Albert-Laszlo Barabasi, Santiago Schnell,
Alessandro Vespignani & Stanley Wasserman, Eric Wernert

Lead: Micah Linnemeier
Members: Patrick Phillips, Russell Duhon, Tim Kelley & Ann McCranie

Previous Developers: Weixia (Bonnie) Huang, Bruce Herr, Heng Zhang,
Duygu Balcan, Bryan Hook, Ben Markines, Santo Fortunato, Felix
_Tf:lrhorn, Ramya Sabbineni, Vivek S. Thakre & Cesar Hidalg

Gl

Develop a large-scale network analysis, modeling and visualization toolkit
for physics, biomedical, and social science research.

$1,120,926, NSF 118-0513650 award
Sept. 2005 - Aug. 2009

http://nwb.slis.indiana.edu




Aseibeuibengiy Projcct Details (cont.)

NWB Advisory Board:

James Hendler (Semantic Web) http://www.cs.umd.edu/~hendler

Jason Leigh (CI) http://www.evl.uic.edu/spiff,

Neo Martinez (Biology) http://online.sfsu.edu/~webhead

Michael Macy, Cornell University (Sociology) http://www.soc.cornell.edu/faculty/macy.shtml

Ulrik Brandes (Graph Theory) http://www.inf.uni-konstanz.de/~brandes

Mark Gerstein, Yale University (Bioinformatics) http://bioinfo.mbb.vale.edu
Stephen North (AT&T) http://public.research.att.com/viewPage.cfm?PagelD=81

Tom Snijders, University of Groningen http://stat.camma.rug.nl/snijders/

Noshir Contractor, Northwestern University http://www.spcomm.uiuc.edu/nosh

Computational Proteomics

What relationships exist between protein targets of all drugs and all
disease-gene products in the human protein—protein interaction network?
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Figure 2 Drug-target network (DT network). The DT network is generated by using the known associations between FDA-approved drugs and their target
proteins. Circles and rectangles correspond to drugs and target proteins, respectively. A link is placed between a drug node and a target node if the protein

is a known target of that drug. The area of the drug (protein) node is proportional to the number of targets that the drug has (the number of drugs targeting
the protein). Color codes are given in the legend. Drug nodes (circles) are colored according to their Anatomical Therapeutic Chemical Classification, and the
target proteins (rectangular boxes) are colored according to their cellular component obtained from the Gene Ontology databass.
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Computational Economics ol
Does the type of product that a
country exports matter for
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Fig. 1. The product space. (A) Hierarchically clustered proximity (4) matrix
representing the 775 SITC-4 product classes exported in the 19982000
period. (B) Network representation of the product space. Links are color coded
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with their proximity value. The sizes of the nodes are proportional to world
trade, and their colors are chosen according to the classification introduced by
Leamer. 13

Second sight
Computational Social Science
Studying large scale social
networks such as Wikipedia

Power struggle

How do you keep track of the bubbling
mass of information that is Wikipedia?
This chaotic-looking mosaic is one
attempt ta show which tapics are

Second Sight: An Emergent Mosaic of
Wikipedian Activity,
The NewScientist, May 19, 2007

pages at the time of writing indude
entries on sheffield Wednesday football
club, Mikhail Gorbachev and pigs).

The mosaic has been commended in
a competition for images that visualise
network dynamics, coinciding with this
week's Inernational Workshop and
& Conference on Network Science
z in Bleomington.
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Computational Epidemics

Forecasting (and preventing the effects of) the next pandemic.

Epidemic Modeling in Complex realities, 1. Colizza, A. Barrat, M. Barthelemy, A.1V espignani, Comptes Rendus

Biologie, 330, 364-374 (2007).

Reaction-diffusion processes and metapopulation models in heterogeneous networks, V. Colizza, R. Pastor-Satorras,

A.Vespignani, Nature Physics 3, 276-282 (2007).

Modeling the Worldwide Spread

of Pandemic Influenza: Baseline

Case and Containment Interventions,

1. Colizza, A. Barrat, M. Barthelemy,
A.-J. Valleron, A.V espignani,
PloS-Medicine 4, e13, 95-110 (2007).

—eImpact or Air Trcwel ON Giobal Spread OF lnFechous Diseases®—

« Reproduciive
Mumber {Ro|

NWB Tool 1.0.0

Can be freely downloaded for all
major operating systems from
http://nwb.slis.indiana.edu

Select your operating system from
the pull down menu and download.

Unpack into a /awb directory.
Run /nwb/nwb.exe

Session log files are stored in
“Syournwbdirectory*/ logs’ directory.

Cite as

NWB Team. (2006). Network
Workbench Tool. Indiana University,

Northeastern University, and University of

Michigan, bttp:/ [ nwb.slis.indiana.edy.
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File Preprocessing Modeling Analysis Visualization  Scientometrics  Help

& console Console displays data operations it D.ata Manager =
™ " (save, load, view, etc.) and r
visualization of small, if @lgerithm input parameters,

selection, & acknowledgements as
The Metwork waorkbery well as error reporting. s supported in part by the MSF Data Manager keeps track of
115-0513650 award, Theprmaryrmresogamorsareorracy ooref, D, Albert-Laszld Barabasi, Dr, Santiago all datasets that are available

Schnell, Dr. Alessandro Yespignani, Dr. Stanley Wasserman, and D, Eric A, Wernert, for algorithmic visualization

The NWE tool was developed by Weixia Huang, Russell Duhon, Micah Linnemeier, Timothy Kelley, Duygu o manipulafion.

Balcan, Mariano Beird, Bruce Herr, Santo Fortunato, Ben Markines, Felix Terkhorn, Heng Zhang, Megha
Ramawat, César Hidalgo, Ramya Sabbineni, Yivek Thakres, Soma Sanyal, Ann McCranie, Alessandro
‘Wespignani, and Katy Barner, It uses the Cyberinfrastructure Shell (hitp:/ /cishell.org) developed at the
Cyberinfrastructure For Metwork Science Center (http://cns.slis.indiana.edu) at Indiana University,

Please cite as follows:
MWE Team, (2006), Metwork Warkbench Toal, Indiana University and Mortheastern University, =

http:/ /nwb.slis.indiana.edu -
L ! 7 = = Table
B scheduler Scheduler lists what algerithms you've =57 )
used and displays algorithm L Matrix:
B plot

rogress.
s
G GuEss

| I Algorithm Marme Date Time % Complete | '\?
| Tree
[

@« Network-

Console shows references to seminal works.

Workflows are recorded into a log file, and soon can be re-run for easy replication.

All algorithms are documented online; workflows are given in tutorials.

File, Preprocessing, Modeling, and Visualization Menus

File Preprocessing Modeling Wisualization

Load... Extract Top Modes Random Graph GLESS
Load and Clean ISI File Extract Modes Abave or Below Yalue Watts-Strogatz Small warld GruPlat
Read Directary Hierarchy Remove Mode Attributes Barabasi-lbert Scale-Free
Datasets Delete High Degree Nodes . DrlL (WxOrd)
Delete Random Modes Specified {prefuse beta)
Save. .. Chord
Delete Isolates X X
Hypergrid Circular {IUNG)
Wigw. ..
) ’ Extract Top Edges FRU )
View with... Extrack Edges Above or Below value Rad!al i (Frefuse alpha)
TARL Radial Tree/Graph with Annotation {prefuse beta)
Merge Node and Edge Files Remove Edge Attributes Y
Split Graph to Made and Edge Files|  Pemave Self Loops Discrete Metwork Dynamics (DHDY

K Tree View (prefuse beta)
Trim by Degree X X
Tests Evalving Mebwork {Weighted) Ealloon Graph (prefuse alpha)

Snowball Sampling {n nodes)

Preferences Node Sampling Farce Directec! with Annotation (prefuse beta)
" Kamada-Kawai {JUNG)
Exit Bl Sl Fruchterman-Reingald (JUMNG)
Symmetrize Fruchterman-Reingold with Annotation {prefuse beta)
Dichotomize Spring {JUNGE)
Multipartite Joining Small World {prefuse alpha)

lormalize Texh

Parallel Coordinates (d
Slice Tiable by Time ardllel Coordinaizs (daino)

Lahet

Circular Hierarchy

Borner, Katy, Sanyal, Soma and Vespignani, Alessandro (2007). Network Science. In Blaise Cronin (Ed.),
ARIST, Information Today, Inc./ American Society for Information Science and Technology, Medford, NJ,
Volume 41, Chapter 12, pp. 537-607.

http://ivlslis.indiana.edu/km/pub/2007-borner-arist.pdf
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Analysis Menu and Submenus

Analysis | Unweighted and Undirected 3 | Urwweighted and Directed »
Network Analysis Toolkit (NAT) Node Degree Mode Indegree
Unweighted and Undirected Deqree Distribution E:jde Ol.t;:r.e;t.
legree Distribution
Weighted and Undirected Watts-Strogatz Clustering Coefficient o d:gec .
Unweighted and Directed Watts Strogatz Clustering Coefficient over K
‘Weighted and Directed - K-Mearest Neighbor
Drameter Single Node In-Out Degree Correlations
Search Average Shortest Path !
Discrete Network Dyniamics shortest Path Distribution PageRank
Textual Mode Betweenness Centrality HITS
Global Connected Components Dyad Reciprocity
Weighted and Undirected v HITS Arc Reciprocity
. sfficient ) Adjacency Transitivicy
Clustering CoefFici Weak Component Clustering
Nearest Neighbor Degres Blondel Community Detection Weak Component Clustering
Strength vs Degree Strong Component Clusterin
Degree & Strength MST-Pathfinder Network Scaling e > .
Average Weight v End-paint Degree ER— Blondel Community Detection
K-Nearest Neighbor (Java) Annotate K-Coreness Extract K-Core
Strength Distribution Annotate K-Coreness
Weight Distribution ‘weighted and Directed O
Randaomize Weights HITS Search  » I
MST-Pathfinder Network Scaling Weighted PageRank Can
Fast Pathfinder Network Scaling Fast Pathfinder Network Scaling iz , -
- - K Random-¥Walk Discrete Network Dynamics 3
Blondel Community Detaction Blonde| Community Detection Random Breadth First Extract and &nnotate &ttractors

Borner, Katy, Sanyal, Soma and Vespignani, Alessandro (2007). Network Science. In Blaise Cronin (Ed.),
ARIST, Information Today, Inc./American Society for Information Science and Technology, Medford, NJ,
Volume 41, Chapter 12, pp. 537-607. http://ivL.slis.indiana.edu/km/pub/2007-borner-arist.pdf 19
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GUESS
Gnuplot exploratory data analysis and visualization tool
portable command-line driven for graphs and networks.
interactive data and function plotting https://nwb.slis.indiana.edu/communitv/?n=Vi
utility http://www.gnuplot.info/. sualizeData.GUESS.
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m Supported Data Formats

The NWB tool supports loading the following input file formats:

GraphML (*.xml or *.graphml)

XGMML (*.xml)

Pajek .NET (*.net) & Pajek .Matrix (*.mat) Qi ccsgrmiom Q..

NWB (*nwb) 2 du.berkel i nG h. "
edu.berkeley.quir prefuse.graph.Grap|

TreeML (*.xml) | JTRR—

Edge list (*.edge)

CSV (*.csv) Oy

IST (*.isi) O K ccimeniomi @ prefuse.data Graph

Scopus (*.scopus)

NSF (*.nsf) . . S . file:text/referbib

Bibtex (*.bib) eresraphmi

Endnote (*.enw) Qo

and the following network file output formats: [ 1 .

GraphML (*.xml ot *.graphml) f Qi L ——

Pajek .MAT (*.mat) . file:application/pajeknet \

Pajek NET (*.net) X

NWB (*nWb) . file:application/pajekmat . e
XGMML (*.xml) appemRenR

CSV (*.csv)
Formats are documented at https:

[ eduuciicsjung graph.Graph ®

refuse.dataTable

. file:text/bibtex

VVVVYVYVYVYVVYYVYVYY

YVVVYVVYYVY

nwhb.sl

is.indiana.edu/community/?n=DataFormats.HomePage.

® iicons
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Workshop Overview

9:00 Marcoscope Design and Usage & CIShell Powered Tools
9:15 Sci2 Tool Basics
»  Download and run the tool.

9:30 Sci2 Workflow Design: Padgett's Florentine Families - Prepare, load, analyze,
and visualize family and business networks from 15th century Florence.

10:00 Sci2 Tool — Using Text and Database Support
»  Studying Four Major NetSci Researcherts.

» Load and clean a dataset as text file or using the Sci2 Database; process raw
data into networks.

»  Find basic statistics and run various algorithms over the network.
»  Visualize the networks as either a graph or a circular hierarchy.
10:15-10:30 Break

10:30-11:00 Sci2 Research Demonstration I: Indiana Philosophy Ontology Project -
Map concepts and influence in the field of philosophy.

11:00-11:30 Sci2 Research Demonstration II: The Letters of Athanasius Kircher.
11:30-12:00 Q&A and Technical Assistance
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CIShell Powered Tools:

Science of Science (Sci2) Tool

Science of Science (Sci2) Tool
http://sci.slis.indiana.edu

» Explicitly designed for SoS research and practice, well documented, easy to use.

» Empowers many to run common studies while making it easy for exports to
perform novel research.

A\

Advanced algorithms, effective visualizations, and many (standard) workflows.

Y

Supports micro-level documentation and replication of studies.

» Is open source—anybody can review and extend the code, ot use it for
commercial purposes.

SUMMARY
e Existing metrics have known flaws
e Areliable, open, joined-up data
infrastructure is needed
e Data should be collected on the full
O P | N | O N range of scientists’ work
e Social scientists and economists
should be involved

nature Vol 464|25 March 2010

Let's make science metrics more scientific

To capture the essence of good science, stakeholders must combine forces to create an open, sound and
consistent system for measuring all the activities that make up academic productivity, says Julia Lane.
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Sci? Tool — “Open Code for S&T Assessment”

Joint Co- Authorship Neework

OSGi/CIShell powered tool with NWB plugins and =

many new scientometrics and visualizations plugins.
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GUESS Network Vis

Borner, Katy, Huang, Weixia (Bonnie), Linnemeier, Micah, Duhon, Russell Jackson, Phillips, Patrick, Ma, Nianli, Zoss,
Angela, Guo, Hanning & Price, Mark. (2009). Rete-Netzawerk-Red: Analyzing and Visualizing Scholarly Networfks
Using the Scholarly Database and the Network Workbench Tool. Proceedings of ISST 2009: 12th International Conference
on Scientometrics and Informetrics, Rio de Janeiro, Brazil, July 14-17 . V'ol. 2, pp. 619-630.

\% Sci Tool
File Preprocessing Modeling  Analysis | Wisualization | Scientometrics  Help
. GLESS
E Console.
GruPlot

Nelcorne to the Science of Science Tool (Sci
The development of this toal is supported i
Metwark Science center and the Schoal of Li
Indiana University, the Mational Science Foul
and I15-0715303, and the Jarmes 5. McDonnel
Cyberinfrastructure portal thttp:fscislis.ind

The primary investigators are Katy Bérner, In
SeiTech Strategies Inc, The Sci® tool was dew
1. Duhan, Patrick &, Phillips, Chintan Tank, a
Cyberinfrastructure Shell thitp:/fcishell.org
for Metwork Science Center (httpaficns.slis.i
Many algorithm plugins were derived from 4
{http:finwb.slis.indiana.edu).

Flease cite as follows:
Sei® Tearn, (20093, Science of Science Toaol, T
Strategies Inc,, http:ffscislis.indiana.edu.

=] Scheduler|

Rernowve Frorm List | [ Remove completed

Radial Tree/Graph (prefuse alpha)

Radial Tree/Graph with Annotation (prefuse beta)
Tree View (prefuse beta)

Tree Map (prefuse beta)

Force Directed with Annotation (prefuse beta)

Fruchterman-Reingold with Annotation (prefuse beta)

DL QfOrd)
Specified (prefuse beta)

Haorizantal Line Graph

Circular Hierarchy

Geo Map (circle annotations)

Geo Map (regioh coloting annotations)

Irmage Wiewer

Reftdapper
! Algorithm Mame Date Tirme % Corr
¥ Extract Co-Author Metw...  09/03/2009 00:15:20 &0 | —
Load and Clean ISIFile 09/03/2009 0015054 —
<1 1 |
“ [l

Circular Hierarchy
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A ool for

I .
«flp Sci? Tool: Download, Install, and Run
o &';.__:__.

SCiZ TOO]l Alpha 3 (MaI’Ch 2010) . ':'f""“"':" ] """'1'1 "t”ml’-:-:p'-:-n'-r
Can be freely downloaded for all major
operating systems from
http://sci.slis.indiana.edu/sci2

- - Sci? Tool
Select your operating system from the 5 Atoot o clence of slence eseasch & pracice
% ot
pull down menu and download. e

Unpack into a /sci2 directory.
Run /sci2/sci2.exe

Tutorial is linked from web page.

e, Kaey Bemsr,

Brvin W, Beyack, Ml W, Lissesseiee Runsell | Do, Puirck A, P, Chistas Tk, s Foveph
} Tosd User Manual, C Bntwerk Sesmnce Cester, Sebocl of L

Kby Bermer ind Asgels Zows (2010) Flug-and Pl Masrastvpes Tuiacial Ieteessturmsl Conformnce oo Socul Computing Bebaviond Medebng end
Peadenon Bathesty 100

In the mews

Cite as R ——
Se? Team. (2009). Science of Science (Se?) Tool f ™=

Indiana University and SciTech Strategies, e . - :

besp:/ [ sci.shis.indsana.edu s

oo @ oo G- Hiow -«
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Sci? Tool: Download, Install, and Run

Sci? Tooll Alpha 4 (Aug 2010)

Has new features such as N;m;m =
> STAR database i2010-03-sci2-manual.pdf 10,947 KB
. Q-Z4)
> COlored Horlzontal Bar Graphs |4 5ei2-N-10.0.201008130505NGT-racascarbon.ppe zip 91,415 KB
> Supports ASCII UTF_S Charactefs ) 5ci2-M-1.0.0,201008130505MGT-racosx.carbon.x86 zip 91,414 KB
_%,J sri2-M-1.0.0.201008130505NGT-macosx cocoaxBi_fidzip 89,717 KB
> Bug ﬁXCS, Streamlined WOIkﬂOWS ) 5ci2-M-1.0.0,201008130505MN G T-win32.win 32,486 zip 91,374 KB

NEH Tutorial beta version was made available on DVD for Windows, Mac, and

Linux. Unzip and run /sci2/sci2.exe [l 7" _ 31374 K8
K sciz Browwse with Corel Paint Shop Pro Photo X2

Open Comrnand Prompt Here

Extract All...

Scan forViruses..,

7-Zip 3 Open archive

Open With... Extract files..,

. . = A Extract Here

Pre-release of tutorial is at @ Magielso ,

bitp:/ [ ella.slis.indiana.edu/ ~katy/ outgoing/ S ci2 Tutorial Alpha4-NEH-W orkshop.pdf
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i 282 Compute Basic Netwark
2 Getting STarted s sssneed " 634 Mapping the Diffusion of Information Among Major U5, Research Institutions [2006)
) 283 Network Analysis
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23 Userion 284 Network
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121 210 Moceling [Why?) ) .
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6.2 Local Impact-Output / ROI Stucies

461 Burst Detection...

162 Slice Tabke by Time 621

Indicator-Assisted Evaluation and Funding of Research: Visualizing the Influence of Grants on the

Number and Citation Counts of Research Papers [2003] F 3
47 Geospatial Analysis (Where) ] - )
622 Mapping Transdisciplinary Tobacco Use Research Centers for 8
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631 Mapping the Evolution of in Networis (2004) 19

63.2 Studying the Emerging Global Brain: Anslyzing and Visualizing the Impact of Co-Authorship Teams
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Sci2 Tool Intetface Components

Use

Menu to read data, run
algorithms.

Console to see work log,
references to seminal works.
Data Manager to select, view,
save loaded, simulated, or
derived datasets.

Scheduler to see status of
algorithm execution.

\¥ 8ci2 Taal ==

File Data Preparation Preprocessing  Analysis  Modeling  Visualization  Help

& cansole| = O it Data Manager, = B
Welcome ta the Science of Science Toal (Sci®). - ? Directory Tree - Prefi

The development of this taal is supparted in part by the Cyberinfrastructure for
Metwork Science center and the School of Library and Information Science at Indiana
Uniwversity, the Mational Science Foundation under Grant Mo, SBE-0738111 and
[OS-0715303, and the James S, McDaonnell Foundation, See Science of Science
Cyberinfrastructure portal (http:isci.slisindiana.edu) for more information,

Prirmary irvestigators are Kty Bamer, Indiana University and Kevin W, Boyack, SciTech
Strategies Inc, The Sci® tool was developed by Micah W, Linnerneier, Russell ) Duhan,
Patrick A. Phillips, Chintan Tank, and Joseph Biberstine. It uses the Cyberinfrastructure

Shall Mt tebnll el el ot bl Cbesiofes b icbuewn Foe Mabai el Soinncn

& Scheduler| =0

[l Remave campleted automatically | Rernowe all completed

| Algorithm Name Date Time % Compl
[¥] Read Directory Hierarchy  08/15/2010 70517 PN
4 . ] b

All workflows are recorded into a log file (see /sci2/logs/...), and soon can be re-
run for easy replication. If errors occur, they are saved in a error log to ease bug

reporting.

All algorithms are documented online; workflows are given in tutorials, see

http:

sci.slis.indiana.edu/sci2 and http:

nwhb.slis.indiana.edu > Community
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Sci2 Tool — Read+Visualize Sci2 Tool Directory Tree

Use File > Read Directory Hierarchy’ with parameters

I Read Directory Hierarchy

Roat directory I C:\Documents and Settings\katy\Desktophrwb

Levels to recurse | 1
¥ Recurse the entire tree

™ Read directories only (skips Files)

Canicel |

X

3
&
3

9

W

Visualize resulting ‘Directory Tree - Prefuse (Beta) Graph’ using

o Visunalization > Tree View (prefuse beta)’
o Visnalization > Tree Map (prefuse beta)’

o Visualization > Balloon Graph (prefuse alpha)’
*  Visualization > Radial Tree/ Graph (prefuse alpha)’

31

Different views of the
/nwb directory
hierarchy.

Note the size of the
/plugin directory.

B BalloconTree

(org.eclipse.update

GUESS

THTET) (ZGMML Files,

socialscience

P ETA-INF
)

oig.eolipse equinoapp
a1g.eclipse.osgl

FresHEP WectorGraphics 1.0.0

arg prefuse lib_20060715.0.0

o1g._cishell templates jythanmunner,

=100

a0z

(lismeree=]

FTE Files, T,
wurkspace
NotUsed Fajek HET File: \ aduuciicsjung_17 A METAINF
og-cishellenvirenmentsquinoxizaturs
(Featuras fuv it javaslgorithmfesture
[du.iv.nmib_convererieature_1.00
e
oigcishelltesture_100

B ajek MAT Files) Znvarter test files

META INF

org cishell reference gui feature

& du.iu.nwbgui-brand featur_1.0.0
rg vishell ieference feature_1.0.0

Bial
Tology |2

Ecunumlcs




Workshop Overview

9:00 Marcoscope Design and Usage & CIShell Powered Tools
9:15 Sci2 Tool Basics
» Download and run the tool.

9:30 Sci2 Workflow Design: Padgett's Florentine Families - Prepare, load, analyze,
and visualize family and business networks from 15th century Florence.

10:00 Sci2 Tool — Using Text and Database Support
»  Studying Four Major NetSci Researchers.

» Load and clean a dataset as text file or using the Sci2 Database; process raw
data into networks.

»  Find basic statistics and run various algorithms over the network.
»  Visualize the networks as either a graph or a circular hierarchy.
10:15-10:30 Break

10:30-11:00 Sci2 Research Demonstration I: Indiana Philosophy Ontology Project -
Map concepts and influence in the field of philosophy.

11:00-11:30 Sci2 Research Demonstration II: The Letters of Athanasius Kircher.
11:30-12:00 Q&A and Technical Assistance

33

Padgett's Florentine Families - Compute Basic
Network Properties & View in GUESS

Florentine families related through business ties (specifically, recorded financial
ties such as loans, credits and joint partnerships) and marriage alliances.

Node attributes
Wealth: Each family's net wealth in 1427 (in thousands of lira)

Priorates: The number of priorates (seats on the civic council) held between
1282- 1344

Totalties: The total number of business or marriage ties in the total dataset of

116 families.

“Substantively, the data include families who were locked in a struggle for political

control of the city of Florence around 1430. Two factions were dominant in this
struggle: one revolved around the infamous Medicis, the other around the
powerful Strozzis.”

http://svitsrv25.epfl.ch/R-doc/library/ergm /html/florentine.html
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Padgett's Florentine Families - Compute Basic
Network Properties & View in GUESS

> Load *yoursci2directory*/ sampledata/ socialscience/ florentine.nwb

» Run Analysis > Network Analysis Toolkit (NAT)’ to get basic properties.

This graph claims to be undirected.

Nodes: 16

Isolated nodes: 1

Node attributes present: label, wealth, totalities, priorates
Edges: 27

No self loops were discovered.

No parallel edges were discovered.

Edge attributes:

Nonnumeric attributes:

Example value

marriag...T

busines...F

Average degree: 3.375

There are 2 weakly connected components. (1 isolates)
The largest connected component consists of 15 nodes.
Did not calculate strong connectedness because this graph was not directed.
Density (disregarding weights): 0.225

» Optional: Run ‘Analysis > Unweighted & Undirected > Node

Betweenness Centrality” with default parameters.

» Select network and run Visualization > GUESS”’ to open GUESS with file loaded.

» Apply ‘Layout > GEM".

35
=101
T =0
.......... .:J o« MNWE file: CiDocuments and Settings|katyiC
GUEhSS(W)as salattaj i B pistribution of degree For network at st
lauthor(s): Eytan Adar o |
limplementer(s): Fytan Adar (GUESS), RussellDuhon (resizelinear, colorizs Fix) E ol Lt of eciges of netiark craated chialgh th
nterator(s). Russell Duhon i M Distribution of degree For network at st
Reference: Adar, Eytan, "GUESS: A Language and Interface For Graph Exploration,” CHI 2006 (http://graphexploration.cond.org;) M Distribution of dearee For netwark at st
a
Eg;%rrﬁnnt;tmn: https://nwh.sl diana.edu,'c /2 Data.GUESS NWE file: C:\Documents and Settingsliaty\l
Starting GLESS... ‘= faraph and Network Analysis Log
FCHO is off. equence of site betweennesses For nod
The initial layout For your visualization is random. For a clearer visualization, please run a layout from the Layout menu. (W' recommend GEM. ) Distribution of site betwesnness for nety
ECHO is off.
A 3 :
I5UUESS log File For this session can be Found in = Distribution of site betweenness For nety
121\ DOCUME- Likaky\LOCALS~ 11 TemplCIShell-Session-55892) StaticExecutableRunner-55 904 ALGORITHM guesslog, txt +'5 " MWE file with site betweenness attribute
""""" . x
1ZLUESS was selected, ualiza DHESS =101
uthor(s): Evean Adar Fle Edt Layout Script  View Help |
Implementer(s): Eykan Ad:
Integrator(s): Russell Dur?‘- Medici-Acciaiuoli (|
Reference: Adar, Eytan, g
Documentation: https://i| 8 Ficld | alue
ECHO Is off, § __edgeid (]
Btarting GUESS... = |business F
CHiovls cff, % color dandelion
The initial layout For vour v | 2
Diinta 5 drected false
\5UESS log File for this sess| 5 [label
-\ DOCUME~ Likaty\LOCA | abelcalor 0,0,0,255
labelsize 12
] scheduler | labelvisible falze
—_ marriage T
Remove From List | [ ¢ [nodet né
nodez ni
visible true
weight 1.0
I [ Agorittmn| MR 20
GUESS
GUESS
~|' Node Betw
[ Network. Ar
| Load...
¥ GruPlot
| | ¥ Gnupiot ; =
i3 AR Ohbiject: | I'| Praoperty: | Operator: | Walue:
¥| Degree Dis T e =
& i | Barabisi-a | Colour ‘ | Show ‘ ‘ Hide | ‘ Size | | Show Label | | Hide Label | ‘ Change Label
| GruPlat
¥ Degres Dis ‘ Hode Shape ‘ | Center | | change History |
v GUESS
Y Load...
| Interpreter , Graph Modifier |
| K2 | -+ 36




iBix] Pan:
File Edit Layout Script  Wiew Help “grab” the background
Medici ¢ by holding left-click
N ; .
§ | Field | vale J and moving your
é color cornflo...
< |fixed false mouse.
g fheioht 10,0 a
5 [image
E [label Medici /.oom:
— |labelcolor 0,0,0,... .
Isbelsize. |12 Using scroll wheel,
labelvi... fake €y «
ISR s ‘i‘a press th; +” and “-
original... Medici buttons in the upper-
D{‘“:':es 53d = Color... left hand corner, or
stroke... cadeth... . .
Remave h - h k d m
svle 2 right-click and move
. Add :
totalties S4 e Fild the mouse left or right.
visible  true O odify Field. ..
wealth 103 m Copy as Yariable, .. Cente.r graph by
widh 10,0 selecting “View ->
£ 90,625.., >
.y daiz e Centet’.
Av* Select %to
select/move single
Object: | |V| Property: |Iabelsize v| Operatar: Yalue: EI / &
nodes. Hold down
| Colour | | Shiow | | Hide | | Size | | Show Label | | Hide Label | | Change Label | ‘Shift’ to SClCCt
‘ Format Mode Labels | | Format Edge Labels | mU-hjple.
| Mode Shape | | Center | ‘ Change Histary |
| Resize Lingar | | Colorize | nght Cth to mOdlfy
Color, etc.
|N0des v| |Iabelsize v| From: | | Tt | | | Do Resize Linear
Interpreter . Graph Modifier )"
37
Graph Modifier:
Yisualization - GUESS 100 x|
[13 2 M
T T e mm G Eh | Select “all nodes” in the Object
Pucci | drop-down menu and click ‘Show
B ‘
g Fed | vake ‘,’ Label’ button.
E color 255,25..,
< [fixed False
E ‘“r:"agg:t 5.0 ‘ Castellani) Select ‘Resize Li > Nodes >
g . samagir) G0 e e(?t. ,eslze inear odes
~ |labelcalor 0,0,0,... —
bckc [0, Lo HESEN) poruzziy sanat) totalities’ drop-down menu, then
labeli... trus ‘i&l ALY type “5” and “20” into the From”
name niz
ariginal... Pucci _ P Pazzi) and To” Value box separately.
priorates O Bischeri) Ridolfi)
£ < M M ol
k... cadet.. | Meici) Then select ‘Do Resize Linear’.
shyle z
Tstiab\li:es E,UE . Tomabuoni) Acciaiuoli’)
¢ .
wealkth 3 Ly Select ‘Colorize>
dth 5.4 ..
e Nodes>totalities’, then select
G 1< Pusci) white and enter (204,0,51) in the
pop-up color boxes on in the
A “From” and “To” buttons.
Obijeck: | ‘V‘ Propetty: ‘Iabels\ze V| Operatar: Value: El
13 b
| Calour ‘ | Shaw | ‘ Hide: | | Size: | | Show Label | ‘ Hide Label ‘ | Change Label ‘ SeleCt Format NOde Labels >
|l Format Node Labels || | Format Edge Labels | replace default text {Orlglnallabel}
| Mode Shape | ‘ Cenker | ‘ Change History | Wlth your own label n the pop—up
¢ . .
box ‘Enter a formattmg string for
node labels.”
Inkerpreter . Graph Modifier }‘
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Visualization - GUESS 10l x|
File Edit Layout Script  Wiew Help

Acciaiuoli:) |{

Field | Yalue o
color 255,24,
fixed false
feight |5.6635... a Castellani)
image o
label Acciaiu. .. Barbadort) Ginori)
labelcolor 0,0,0,... Lami Y )
labelsize 12 am L) Peruzzi) - Salviati)
labelvi... true ﬁ . Albizzi;)
1
ome [ Strozzic)
criginal. .. Acciaiuoli _ ) Pazzi)
priorates 53 Bischeri) Ridolfi:) o )
strake... cadeth... Guadagni) Medici:)
style z i
totalities 2 Tormabuoni) Acciaiuoliz)
visible  true ’
wealth 10 m
width 5.6635...
% 11z2.01...
i Lt r‘ﬂ Pucc) Interpreter:
Uses Jython a combination of Java
A and Python.
w
=== resizelinear{totalities,5,20)
=== colorize{wealth,white,red) Try
e
colotize(wealth, white, red)
resizelinear(sitebetweenness, 5, 25)
i Interpreter /f' Graph Mol:lifier}III
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Workshop Overview

9:00 Marcoscope Design and Usage & CIShell Powered Tools
9:15 Sci2 Tool Basics
» Download and run the tool.

9:30 Sci2 Workflow Design: Padgett's Florentine Families - Prepare, load, analyze,
and visualize family and business networks from 15th century Florence.

10:00 Sci2 Tool — Using Text and Database Support
»  Studying Four Major NetSci Researcherts.

»  Load and clean a dataset as text file or using the Sci2 Database; process raw
data into networks.

»  Find basic statistics and run various algorithms over the network.
»  Visualize the networks as either a graph or a circular hierarchy.
10:15-10:30 Break

10:30-11:00 Sci2 Research Demonstration I: Indiana Philosophy Ontology Project -
Map concepts and influence in the field of philosophy.

11:00-11:30 Sci2 Research Demonstration II: The Letters of Athanasius Kircher.
11:30-12:00 Q&A and Technical Assistance
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Eiostior Studying Four Major NetSci Researchers (ISI Data)

Lepes T

el using Database (section 5.1.4)

FourNetSciResearchers.isi

Time frame: | 1955-2007

Region(s): | Miscellaneous

Topical Area(s): | Network Science

Analysis Type(s): Paper Citation Network, Co-Author Network, Bibliographic

Coupling Network, Document Co-Citation Network, Word Co-
Occurrence Network

Thomson Reuter’s Web of Knowledge (WoS) is a leading citation database cataloging
over 10,000 journals and over 120,000 conferences. Access it via the “Web of
Science” tab at http://www.isiknowledge.com (note: access to this database requires
a paid subscription). Along with Scopus, WoS provides some of the most
comprehensive datasets for scientometric analysis.

To find all publications by an author, search for the last name and the first initial
followed by an asterisk in the author field.

41
- & 1ol for o« o e .
~Fo | Data Acquisition from Web of Science
S0 150 Wb of Knowbedips [vL1] - Setscipe =0l x|
< Be [0t Yew o focimads Jook Wrdow beb
Download all papers by Q000 S D Q9
L e B scace Q Smch | Cumonte... ) oot
[ e ) s i | T R = F 5
» FBugene Garfield e RS
151 Web of Knowledge™ [0 |
» Stanley Wasserman Web of Science® E
] ) o] 7 00) 5 ) [ [
» Alessandro Vespignani Ganeral Saarch RS
Helect database(s) and timespan: b Y |
» Albert-Laszl6 Barabasi e Oy - = s
B D Soxisl Sciances Cation Index (SECI)-=1955-prusent & Frem 1993 =] to [zeo7 =] (default is 8l years)

fro ) Arts I bumarition Citation Index (ABHCT)-=1075-prasent Ta remember these settings, first ggn in of register
Enter terms or phrases separated by the cperators AND, OF, NOT, or SAME, and then 9|O§! SUARCH,
The search will be added to the search history. [x2 View your search histong/Combers

» Science Citation Index =) £

TOPIC: § Entor oo o mom taems. SAAMChas witkin artica titks, kaywords, and abstracts.
Example: ol spil® AND “Horth Sea® (How to search for pheazes)

Expanded (SCI-EXPANDED) . o

{ AUTHOR: 1) Eriter one or more author names (see guthor index K.
: O'BRIAN C* OR OBRIAN C*

Viw dur Gardesl Sharch tutodial

_ 1 9 5 5_present uther Finder: Heed help finding papers by an author? Use Author Finder,
CWMTB::,: 1) Enter one or more group names (soe group author indes .
» Social Sciences Citation Index f

BOURCE TITLE: i Enter full joumal titkes (soe fill source titles kst ).

Evample: Cancer* Of Journal of Cancer Research snd Clrical Oncolos
(SSCI)--1956-present l i

PUBLICATION YEAR: i) Enter & pubhcation yaar of range
Example: 2001 or 1997-199%

» Arts & Humanities Citation
An?:zm :Unf: ::-—:w;aumalw rarms from an authee's affilation (use sbbravitions haip).
Index (A&HCI)--1975-present l

Restrict search by languages and documant types:

Bnghah Py
afr s ns et o Bobbahad e

S@aiwna ESLor
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Comparison of Counts
No books and other non-WoS publications are covered.

Séarch & practice

Age Total # Cites Total # Papers H-Index
Eugene Garfield 82 1,525 672 31
Stanley Wasserman 122 35 17
Alessandro Vespignani 42 451 101 33

Albert Laszl6 Barabasi 40 2,218 126 47 (Dec 2007)
41 16,920 159 52 (De 2008)

43
Extract Co-Author Network
Load*yoursci2directory*/ sampledata/ scientometrics/ isi/ FourNetS ciResearchers.isi’
using 'File > Load and Clean IS] File* and parameters
5] Load
— The file you have selected can be loaded using one ar
mare of the following formats.
— Please select the format you would like to try,
Load as...
SIschalarly format 1 % Sei2 Tool [ )
I3l database FilemmDR repara o e praEEssirgm AT sisamtv ol imemmiisual st el
El consale| = O 6t Data Manager| =g
[E F7] 151 Data: CivllsersiUserDesktoph10-MEH-A&H-Worksho
o (A, B = "
Authar names have been normalized.

361 records with unique ISTIDs are available via Data Manager,

Wrate log to
Chllsers\UsenvdppDatatlocal\Temphisiduplicateremowverlog2534733993422022

And file with 361 records | [ E
EJ Scheduler| =0
[ Rernave completed automatically | Remave all complete

appears in Data Manager.

| Algarithm Name Date Time %
I Loadand CleanISIFile  08/15/2010  07:29:43PM

] Load and CleanISIFile  08/15/2010  07:12:49PM
< i ]

1|« m r
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Extract Co-Author Network

(see section 5.1.4.2 on corvecting duplicate/ misspelled author names)

To extract the co-author network, select the 367 Unique 151 Records’ table and run
‘Data Preparation > Text Files > Extract Co-Author Network’ using isi file format:
=

Extracts a co-authorship network from one of several supported file
types.

File: Formak Iisi =3
Cancell

The result is an undirected but weighted network of co-authors in the Data Manager.

Run ‘Analysis > Network > Network Analysis Toolkit (NAT)’ to calculate basic
properties: the network has 247 nodes and 891 edges.

Use ‘Analysis > Network > Unweighted and Undirected > Node Degree’ to calculate the number
of neighbors for each node.

To view the complete network, select the ‘Extracted Co-Anthorship Network’ and run
Visualization > Networks > GUESS".

Network is loaded with random layout. In GUESS, run T.ayout > GEM’ and ‘Layout
> Bin Pack’ to improve layout.

45

Co-Author Network of all Four NetsSci Researchers

Node Size & Color
Number of Papers

e 127
Eugene Garfield
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“A ool for

bpce ot cionce

A iwsw Co-Author Network of all Four NetsSci Researchers

Use the GUESS Graph Modifier to change

colot and size Coding. Joint Co-Authorship Nerwork

v BT \ [/ Nade Size & Color Edge Size & Color
"~_\ ¥, Number of Papers Number of Times
. Co-Authored
T 127

Engene Garfield 33

35 9

5 1

| ]

1 127 1 33
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“A ool for

Individual Co-Author Networks
(Read/map 4 files separately)

o6l beiotice
farch& practice

Albert-l.aszlo Barabasi

Alessandro Vespignani
48




Network Visualization:
Node Layout

Load and Clean ISI File was selected.
Loaded 361 recotds.

Removed 0 duplicate records.

Author names have been normalized.

361 records with unique ISI IDs are available
via Data Manager.

Extract Co-Author Network was selected.
Input Parameters:

File Format: isi

Network Analysis Toolkit (NAT) was selected.

Nodes: 247
Edges: 891 .
.......... . '. A
GUESS was selected. . .
e T
[
W
L ]
o/
«*
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Network Visualization:
rch & practice . . .
- Color/Size Coding by Data Attribute Values
o2
._!
A
% 5 Visualization - GUESS
File Edit Layout Script  Wiew Help
Wespignani, A N
_§ Field | Yalue
g color 125,12,17,255
< [fixed false
2 |height 10.0
E |
= [mage
'E |label Vespignani, &
— [labelcalor 0,0,0,255
labelsize 12 -
labelvisible false ® Node Size & Color Edge Size & Color
narme nigl Y Number of 3’.:|r|~ Number of Times
numberofwarks 101 Co-Authored
originallabel Vespignani, & P
strokecolor black 'ﬂ L 33
style 2 [ ] ]
timescited 3511 35 | 1
visible true = (5}
C—T B T
£ 586,75
$ gl B 1 127 1 3




Network Visualization:
Giant Component

rch & practice

Weak Component Clustering was selected.
Implementer(s): Russell Duhon
Integrator(s): Russell Duhon

Input Parameters:
Number of top clusters: 10
3 clusters found, generating graphs for the top 3 clusters.
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Network Visualization:
Color/Size Coding by Degree

Node Degree was selected.
Documentation:
https://nwb.slis.indiana.edu/community/?n=AnalyzeData.No
deDegtee

52




oot Network Visualization:
Color/Size Coding by Betweeness Centrality

iifpen et heionce
Srosfarch & practice

AN azquez, A
# Pastor-satoftas, R
.

Node Betweenness Centrality was selected. .
Authort(s): L. C. Freeman

Implementer(s): Santo Fortunato

Integrator(s): Santo Fortunato, Weixia Huang

Reference: Freeman, L. C. (1977). A set of measuring centrality

based on betweenness. Sociometry. 40;35-41. *

Input Parameters:
Number of bins: 10

umber of bins: 10

Network Visualization:
Reduced Network After Pathfinder Network Scaling

r

W00 eMakesv, MA »

. Wiegk T . . éﬂ, HE

. " ’
th ®Jeong, H *
oHavIRL 8 | oKahiig B "
2\, ez
. LA B -
.. - - -
= MR AN ot
9 p _.érahad. AL i
. . ae] - .z?r(
v ASe R AL LA ’ e ®Pasorsatomas,Re  eloreto, V
- . . ® o]
®0mva, 2N = "/é
o aesignanl. A,
" eVadz, A L E
@A, R .Ph‘lm:wu L
* 4 eBarthelemy, M
‘ L ®Bamat A
MST-Pathfinder Network Scaling was selected. . - .
. '\
Input Parameters: < i3
Weight Attribute measures: SIMILARITY { "

Edge Weight Attribute: weight




Network Visualization:
Circular Hierarchy Visualization

Select Co-Author Network and run Blondel Community detection:

File Data Preparation Preprocessing [Analysis] Modeling  Visualization Help

E Consale Temporal b = O || 5 Data Managerl

e Clean IS File was selectad et b 2| 4 BT 151 Data: CallsersiUseriDesktopt10-NEH-A&H-Workshap\DYDisci\sampld
Author(si: Micah Linnermeier el ' 4 [ 361 Unique ISI Records

Implementeris): Micah Linnemeier Metwarks ] Metwark Analysis Toolkit (MAT) on

Integratar(s): Micah Linnemeier MetSciResearchers.isi
Documentation: Urweighted & Undirected * e merned
IEtt|';s:.;.fnwh.slis.indiana.edul’com munityfIn=LoadData.ISILoadAr Weighted & Undirected v Clustering Coefficient

oaded:

CiUsers\User\De sktaph10-MEH-A8&H-WorkshophDVDsciZisample Unweighted & Directed 4 Mearest Meighbor Degree
ornetricshisiVFourbetSciResearchers.isi Weighted & Directed » Strength vs Degree

Loaded 361 records. 4 151 Data: C:TLlusers\Use Digree € Eemgiy

Removed 0 duplicate records. 4 361 Unique ISI Re Ayerage Wieight vs End-point Degree
Author names have been normalized, o T

o« Extracted Co-2 Strength Distribution

361 records with unique ISIIDs are available wia Data Manager, Authar inform Weight Distribution

sirate log to Randorize Mieights
Chlsers\UservdppDatatlocal Temphisiduplicaterernoverlogd773522398971021 = =
78t Blondel Community Detection
C'C lth parameter ValuCS 5| Blondel Corrnunity Detection @

This algorithm implernents Blondel's community detection
algorithm.

Wieight ’numberofcoauthoredworks v]

wt
a

Network Visualization:
Circular Hierarchy Visualization

Visualize resulting file using ‘VZsualization > Networks > Circular Hierarchy’
with parameter values

5| Circular Hierarchy ==

Prowvides Circular Hierarchy Visualization on the network,

Degree of Edge Bundling  0.75

MNode Strength Column ’timescited v]
Lewel ’blondel_communit}-’_level_ﬂ v]

Lewel 1 ’blondel_communit}-’_level_l v]

Lewel 2 ’blondel_communit}-’_levelj v]

Lewel 3 ’No Lewel ']

Edge ¥Weight Column ’numberofcoauthoredworks v]

MNode Color Column ’numberofworks v]

MNode Color Range ’Green o red




Network Visualization:
Circular Hierarchy Visualization

Nodes that are interlinked/clustered
are spatially close to minimize the
number of edge crossings.

Node labels, e.g.,
authotr names.

Network structure
using edge bundling.

Color coded cluster ————»
hierarchy according to :
Blondel community
detection algorithm.

Note:
Header/footer info, legend, and more meaningful color coding are under development.

Paper-Citation Network Layout

& practice

To extract the paper-citation network, select the 367 Unigue 151 Records’ table and run
‘Data Preparation > Text Files > Extract Paper Citation Network. ¢

The result is a unweighted, directed network of papers linked by citations, named
Extracted paper-citation network in the Data Manager.

Run NAT to calculate that the network has 5,342 nodes and 9,612 edges. There are

15 weakly connected components. (0 isolates)

Run ‘Analysis > Networks > Unweighted and Directed > Weak Component Clustering’ with
parameters

= N =
7] Weak Component Clustering :.Weak Cornponent Cluster of 5151 nodes
o o0 Weak Corponent Cluster of 38 nodes
Creates new graphs containing the top connected cormponents, B Weak Companent Cluster of 35 nodes
2, Weak Component Cluster of 27 nodes
Murnber of top clusters 10' ','. Weak Component Cluster of 27 nodes.2
%, Weak Component Cluster of 15 nodes

to identify top-10 largest components. The largest (giant) component has 5,151 nodes.

To view the complete network, select the network and run ‘Visualization > GUESS".
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Topic Mapping: UCSD Science Map

Science Map via Journals for FourNetSciResearchers.isi

314 joumal references matched out of 361 found.

These 314 references are associated with 13 of 13 disciplines of science and 255 of 554 research specialties in the UCSD Map of Science.

Mo x

\@f &

X 4 Data:

, (5) ©6a WoS and Scopus for 2001-2005, 7.2 million
€ B papers, more than 16,000 separate journals,

57 0 datecions Dacuc proceedings, and series

@& g, Similarity Metric:

Earth Sciences

Combination of bibliographic coupling and

keyword vectors

Number of Disciplines:

554 journal clusters further aggregated into 13

5| Science Map

Locate the journals from a table on the UCSD Map of Science

= main scientific disciplines that are labeled and
color coded in a metaphorical way, e.g., Medicine
is blood red and Earth Sciences are brown as soil.

Journal column Journal Mame (&bbreviated)

Dataset display name  FourMetSciResearchers.isi

’) (@)
(@)

|_ 0K ||Cancal|
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Studying Four Major NetSci Researchers (ISI Data)
(e using Database (sectzon 5.1.5)

Using Database Support — Load a File

Load “*yoursci2directory™/ sampledata/ scientometrics/ isi) FourNetS ciResearchers.isi’, using ‘File
> | oad and select

7 Load ==

The file you have selected can be loaded using one or
maore of the following formats,
Please select the format you would like to try.

Load as...

151 scholarléformat

[ Select H Cancel ][Details >>]

It might take several minutes to load the data into the database.

Select the IST Database in the Data Manger and run ‘Data Preparation > Database > 151

> *’to calculate statistics, e.g., annual counts, extract networks, prepare data for burst
detection, etc.

Studying Four Major NetSci Researchers (ISI Data)
using Database (sectzion 5.1.5)

Using Database Support — View Database Structure
View the database schema by right-clicking on the loaded database in the Data

M’Jﬂ’)ﬂ‘ﬁf,,ﬂﬂ(‘] P]i(‘](1hﬁ ‘6‘71'P‘I7’,

@ 5ciz Tool Mi=IE3| @ B Untitled - Notepad _io
File DataPreparation Preprocessing Analysis Modeling wisuglization Help File Edit Format view Help
=] Cnr\snlel = O || 4 Data Managar} =0

IADDRESS  PK INTEGER, ADDRESS_CITY WVARCHAR, ADDRESS_COUMTF

Al =E.

\\siFuurNetSciResearcer.\s\ AUTHORS { AUTHORS_DOCUMEN
R LRSS ~ AUTHORS_DOCUMENT_FI -
AUTHORSZ_PERSON_FK --—

Fik INTEGER, AUTHORS_PERSON_FK I
—=> DOCUMENT. P
> PERSON. PK

Primary investigatars are Katy Borner, Indiana University
tnd Kevin W, Boyack, SciTech Strategies Inc, The Sciz
ool was developed by Micah W, Linnemeier, Russel J,
Duhan, Patrick A. Phillps, Chintan Tank, and Joseph
Biberstine, It uses the Cyberinfrastructure Shell

Save

Wigws Wik, .,

ICITED_PATENTS ( CITED PATEMTS_DOCUMENT_FK IMTEGER, CITED_F

http://cishell.org) developed at the Rename CITED PATENTS _DOCUMENT_FK ---—-  DOCUMENT. PK
Cyh;\éﬁ'astructuregf)nr ekhiork Stisncs Center Discard CITED PATENTS _PATENT _FK ----- » PATENT. PK
http://cns.slis.indiana.edu) at Indiana University,
any algorithm plugins were derived from the Metwork (CITED_REFERENCES  CITED_REFERENCES_DOCUMENT_FK INTEGER, ©
orkbench Tool http://nwb.slis.indiana.edu. CITED_REFERENCES_DOCUMENT_FK —— > DOCUMEMNT. PK
j CITED_REFERENCES_REFEREMCE_FK ————- > REFERENCE.PK
=] Schedu\er} =8 DOCUMENT  PK INTEGER, ABSTRACT_TEXT VARCHAR, ARTICLE_NUME
FIRST_AUTHOR_FK —----— > PERSON. PK
Remove From List | [~ Remove completed automatically | DOCUMENT _SOURCE_FK ————- > SOURCE. PK
m DOCUMENT _KEYWORDS ¢ DOCUMENT_KEYWORDS_DOCUMENT_FK INTEGER,
DOCUMENT _KEYWORDS_DOCUMENT _FK ————- > DOCUMENT. PK
DOCUMENT _KEYWORDS_KEYWORD_FK ————— > KEYWORD. PK
1| Algorithm Hame Date
ﬂ Load ISI File Into Database  03/27/2010 DOCUMENT _OCCURRENCES  DOCUMENT_OCCURRENCES_DOCUMENT_FK Ik
Load... e DOCUMENT _OCCURRENCES_DOCUMENT _FK —---= > DOCUMENT. PK
ﬂ | DOCUMENT _OCCURRENCES_ISI_FILE FK —----- > ISI_FILES.PK
4

4 Iﬁ EDITORS ( EDITORS_DOCUMENT_FK INTEGER, EDITORS_PERSON_FK 1




Studying Four Major NetSci Researchers (ISI Data)
using Database (section 5.1.5)

Using Database Support — Data Unification

Run ‘Data Preparation > Database > 151 > Merge Identical IST People, followed by ‘Data
Preparation > Database > 1S1 > Merge Document Sonrces’ and ‘Data Preparation > Database
> IS1 > Match References to Papers’. Make sure to wait until each cleaning step is
complete before beginning the next one. Read red warnings.

vif Sci2 Tool =] (]
File Data Preparation Preprocessing  Analysis  Modeling  Wisualization  Help
El Console = B || ¥ Data Manager =0
21795 cananical farms, ’ - 4 E:‘ whdsivFourMetSciResearchersisi

4 @ I8 Database From . AisivFourMetSciResearchers.isi
4 @ with identical people merged
4 @@ with journals merged
w with references and papers matched

Successfully merged 84 entities into other entities, leaving
2083 entities in the database,

8 Windows Task Manager = feE=d
File Options View Help
Bl Scheduler Applications | Processes | Services | Performance | uetworking | Users

n . CPU Usage (CPU Usage Histary
Rernove Fram List | [C] Remove cornpleted automatii

! Algorithm Mame Diate
| hdatch Referencesto Pa.,  03/28/2010
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Studying Four Major NetSci Researchers (ISI Data)
using Database (sectzion 5.1.5)

Using Database Support — Extract Basic Properties

Run ‘Data Preparation > Database > 151 > Extract Authors’ and right-click on the
resulting table to view all the authors from FourNetSciResearchers.isi. The table also
has columns with information on how many papers each person in the dataset
authored, their Global Citation Count (how many times they have been cited
according to ISI), and their Local Citation Count (how many times they were cited in
the current dataset).

A [ B | ¢ | o | E ] F [ s | H | 1 | 4 | kK
|1 |UNSPLIT_MNAME PAPERS_ GLOBAL_ILOCAL_CIADDITION: FAMILY _NAME FIRST_INITFULL_MANMIDDLE_Il PERSONAL_MNAME
| 2 |Barthelemy, M 9 454 12 Barthelermy M
| 3 |Barrat, A 13 480 14 Barrat A
| 4 |Pastor-satorras, R 24 1769 48 Pastor-gatorras (R
8 |Wespignani, A 101 381 213 Yespignani A
| B |WWasserman, S 32 675 109 Wasserman S
| 7 |Daruka, | 7 392 11 Daruka |
|8 |Makeev, MA 5] 193 19 Makeey I A
9 |Sidaretti, 3 1 1 1 Sidoretti S
110 |lacobucei, D 5] 115 33 lacobucci u}

(1 [Wazguez, A 10 620 5 “azguez A

|12 | Oliveira, JG 2 20 u] Oliveira J G

|13 |Farkas, | 3 47 1 Farkas |

| 14 |Jeong, H 17 4160 143 Jeaong H

|15 | Oltvai, 7N 17 2961 59 Oltvai z M

16 [Cuerma, R 2 267 11 Cuerno R

17 |Dabrin, R 2 a5 2 Diobrin R

118 |Beg, QK 1 4 0 Beq Q K

19 | Pudavkin, Al 5 32 B Pudavkin A | 64




Using the ISI Database (sectzion 3.1)

Database > IS]

» Extract Authors — Outputs a table containing one row per author in the
database, which includes Papers Authored in Dataset, Global Citation
Count, and Local Citation Count.

» Extract Documents — Outputs a table containing one row per document in
the database, with all bibliographic information related to the document
(including abstract text, if available), as well as Times Cited, Cited Reference
Count, Digital Object ID (if available), and Funding Information.

» Extract Keywords — Outputs a table containing one row per keyword in the
database which includes occurrences of each keyword in the dataset.

» Extract Document Sources — Outputs a table containing one row per
document source in the database, which includes the Full Title, Number of
Papers Contained from the Dataset, ISSN, and other bibliographic
information (if available).

Studying Four Major NetSci Researchers (ISI Data)
using Database (sectzion 5.1.5)

Using Database Support — Records over time

Aggregate data by year by running ‘Data Preparation > Database > 1S1 > Extract Longitudinal
Summary.” Result is a table which lists metrics for every year mentioned in the dataset. The
longitudinal study table contains the volume of documents and references published per year,
as well as the total amount of references made, the amount of distinct references, distinct
authors, distinct sources, and distinct keywords per year.

F1 - % DISTINCT_AUTHORS

[ A ] B [ C [ D [ E | F [ o | v | o+ [ o [ kK | L
R DOCUMENTS_|REFEREMCES_[TOTAL_REFERIDISTINCT_RERDISTINCT AUIDISTINCT DISTINCT DISTINCT_DISTINCT_OTHER_KEYWOR
sl 1995 19 153 672 477 32 3 i 57 i
B4 | 1996 14 143 490 401 23 3 3 62 0
3 1997 13 179 343 289 16 3 4 49 0
56 | 1998 19 159 527 383 23 3 4 57 0
& | 1993 24 176 757 590 39 11 18 94 0
88 2000 19 191 BED 455 28 3 13 57 0
| 2001 28 192 706 497 44 13 13 68 0
a0 | 2002 2 186 770 542 44 11 12 &1 0
91 | 2003 21 144 474 358 51 15 8 62 0
EA 2004 23 94 723 471 34 12 14 B 0
53 | 2005 20 24 542 405 25 13 20 49 0
94 | 2006 3 1 100 94 9 3 3 17 0
55 | 2007 1 0 12 12 1 1 1 2 0
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W8 Studying Four Major NetSci Researchers (ISI Data)

sciifpen Sl Yeiaiitn

“tesl using Database (section 5.1.5)

Using Database Support — Records over time

Aggregate data by year by running ‘Data Preparation > Database > IS1 > Extract Longitudinal
Study” Result is a table which lists metrics for every year mentioned in the dataset. The
longitudinal study table contains the volume of documents and references published per year,
as well as the total amount of references made, the amount of distinct references, distinct
authors, distinct sources, and distinct keywords per year.

900
——DOCUMENTS_PUBLISHED
800 -
200 ———REFERENCES_PUBLISHED
600 ——TOTAL_REFERENCES_MADE
500 ——DISTINCT REFERENCES MADE
400 =
———DISTINCT_AUTHORS
300 i -
200 ———DISTINCT_SOURCES
100 DISTINCT _AUTHOR_KEYWORDS
0 :

ULAALERER RN RN RN RN RE R DlST‘NCT_lSl_KEYWORDS
———=DISTINCT_OTHER_KEYWORDS

1854 7
1897
1906
1920
1929
1936
1944
1949
1954
1959
1964
1969
1974
1979
1984
1989
1994
1999
2004
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_ Studying Four Major NetSci Researchers (ISI Data)
e using Database (section 5.1.5)

Using Database Support — Burst Analysis for References

The queries can also output data specifically tailored for the burst detection algorithm
(see Section 4.6.1 Burst Detection). Run ‘Data Preparation > Database > 151 > Extract

Authors > Extract References by Year for Burst Detection’ on the cleaned database followed
by ‘Analysis > Topical > Burst Detection’ with parameters on left and then run I Zsualize

> Temporal > Horizontal Bar Grapl’ with parameters on right.

] Watch those red warnings!

Perform Burst Detection on time-seties bextual data, x|

Gamma IID— il Takes tabular data and generates PostScript for a horizontal bar graph.

General Ratio IZD— il Label IWord j il

First Ratio EET__________'_ﬁd Start Date [start ;J_ﬁd

Eursting States ll— il End Date IE”d j il

Date Column lh il Size: By IStrength j il

DateFormat  |yyyy il Date Format |Manth-Day-tear Date Format (LL5., e.g. 10f3L/2010) | il

Tesxt Colurmn lm il Year Label Font Size |20.D il

TextSeparator [ il Bar Label Fort Size | 20.0] )
Eancell Eancell
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Diate wud fene of a
Togest cheta: Fuorst et

b 26, 2010 T.43 48 FM EDT
analyas [Year, Redrener). e

1em Frcrat bewed 1

Horizontal Bar Graph for masimum busst level 1

Label Column: Word
Start Date Colume: Start

Size By I:(:nﬂ‘l
Dare Format Colwnn: Mo Try-Yew Date Formar

Year Label Foat Saze: 20,0

Text, e.g., title

Area size equals numerical
value, e.g., award amount.

Start date

End date

Cyhermimutncsure fror Nerwork Soence Crsser (X00) Hemzontal Bar Cloaph. Trdiana Uneeenaty, hitg /s sl iz ol

Studying Four Major NetSci Researchers (ISI Data)

"'“P"“"_'f“ using Database (section 5.1.5)

Using Database Support — Burst Analysis Result

Wasserman S, 1986, BRIT | MATH STAT PSY, V30, F
Wasserman S, 1987, PSYCHOMETRIKA, V52,
Wasserman S, 1985, | MATH PSYCHOL, V29, P406
Fienberg SE, 1985, ] AM STAT ASSOC, V80, P51
Wasserman 5, 1984, SOC NETWOREKS, Vo, P177
Holland PW, 1981, | AM STAT ASSOC, V70, P33
Holland PW, 1983, SOC NETWORKS, V5, P109
Fienberg SE, 1981, SOCIOLOGICAL METHODO
Meyer MM, 1982, ANN STATIS, V10, P1172

Fienberg SE, 1980, ANAL CROSS CLASSIFIE

Bishop YMML, 1975, DISCRETE MULTIVARIAT

White HC, 1976, AM | SOCIOL, V81, P730

Gautield E, 1977, CURR CONTENTS, P35

1972 1973 1974

1976 1977 1978 1979 1980 1981 1982 1983 1984 1985 1980
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Workshop Overview

9:00 Marcoscope Design and Usage & CIShell Powered Tools
9:15 Sci2 Tool Basics
» Download and run the tool.

9:30 Sci2 Workflow Design: Padgett's Florentine Families - Prepare, load, analyze,
and visualize family and business networks from 15th century Florence.

10:00 Sci2 Tool — Using Text and Database Support
»  Studying Four Major NetSci Researchers.

» Load and clean a dataset as text file or using the Sci2 Database; process raw
data into networks.

»  Find basic statistics and run various algorithms over the network.
»  Visualize the networks as either a graph or a circular hierarchy.
10:15-10:30 Break

10:30-11:00 Sci2 Research Demonstration I: Indiana Philosophy Ontology Project -
Map concepts and influence in the field of philosophy.

11:00-11:30 Sci2 Research Demonstration II: The Letters of Athanasius Kircher.
11:30-12:00 Q&A and Technical Assistance

71

Indiana Philosophy Ontology Project — Mapping
Concepts in Philosophy

NATIONAL ENDOWMENT FOR THE HUMANITIES

FOFFICE OF DIGITAL HUMANITIES

INDIANA UNIVERSITY
BLOOMINGTON

InPhO

the Indiana Philosaphy Ontalogy project

The Indiana Philosophy Ontology (InPhO) project offers a variety
of tools for students, researchers, programmers and scholars.
The ontology currently covers philosophical ideas, thinkers,

and journals, and is powered by expert feedback and cutting-
edge machine learning techniques over the 13 million word
Stanford Encyclopedia of Philosophy (SEP).
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S Aisolfar

I gerbeionce -

Concepts in Philosophy

Indiana Philosophy Ontology Project — Mapping

» SEPrelatedness.nwb — Using the philosophy ontology to find related atticles in the

Stanford Encyclopedia of Philosophy

» Open SEPrelatedness.nwb in a text editor.
*Nodesid*int label*string xpos*real ypos*real
1 "law-language" 0.648 0.2027
2 "constructive-empiricism" 0.7694 0.3133
3 "patrizi" 0.45 0.6043
4 "habermas" 0.1964 0.3122
5 "marcel" 0.5689 0.31996

*UndirectedEdgessource*int target*int weight*float

154 433 0.45
417 161 0.62
428 85 0.53
709 349 0.45
647 652 0.68

» NWB Network file includes nodes, edges, and attributes for each

73

Concepts in Philosophy

Indiana Philosophy Ontology Project — Mapping

» Load SEPrelatedness.nwb
» Run ‘Analysis > Network Analysis Toolkit (NAT)’ to get basic propetties.

Nodes: 868

Isolated nodes: 4

Node attributes present: label, xpos, ypos
Edges: 2539

No self loops were discovered.

No parallel edges were discovered.

Edge attributes:

Did not detect any nonnumeric attributes
Numeric attributes:

minmaxmean

weight  0.430.850.53677

This network seems to be valued.
Average degree: 5.8502

» Select network and run ‘Preprocessing > Networks > Delete Isolates

» Run “Analysis > Networks > Weighted & Undirected > Degree & Strength’ selecting
‘weight’ as the Weight Attribute, followed by Analysis > Networks > Weighted &

Undirected > Node Betweenness Centrality’ with default values.
» Run Visunalization > GUESS’ to open GUESS with file loaded.
» Apply ‘Layout > GEM’ followed by ‘Layout > Bin Pack’
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# % Visualization - GUESS

File Edit Layout Scipt View Help
comparphil-chiwes :

E[ Fed | vawe o .
= [color 125,12,17,255
< [fixed false ; ;
5 height 10.0 é "y
= [mage \ ¥ r
'E [label comparphil-chi... o £ .
— |labelcolor 0,0,0,255 o

labelsize 12

labelvisible false N

name n339 £, a- =

originallabel comparphil-chi... Hooa®

strokecolor black :

style 2 @ 5 .

visible true -

width 10.0 o

x 758.25 -0 &

Xpos 0.3251 m

" 2073.25

Ypos 0.7588 r

-

>

Object: lﬂ Property: |lzbelzz= | Operator: Value: EI

olour || show || Hide || sze | Showlabel || Hidetabel || changeLabe

| FormatNodeLabels || FormatEdge Labels |

| Mode Shape ” Center H Change History I

| Resizelinear || colorize |

Zoom Level: |0.08682

Interpreter | Graph Modifier |

Resize Linear > Nodes >
Site Betweenness >
From 7 to 50 > Do
Resize Linear.

Colotize > Nodes >
Strength > |From: l:‘ To:

> Do Colorize.

Resize Linear > Edges >
Weight > 1 to 10 > Do
Resize Linear.

Colorize > Edges >
Weight > From: I:‘ To:

> Do Colorize.

Zoom in to view cliques
& right-click to toggle
labels.

o descartes-works

o,
descarts

descartes-epistemology

= Center On

Color..,

Remove
fdd
Modify Field. ..

Copy as Yariable. ..

)

Resize Linear > Nodes >
Site Betweenness >
From 7 to 50 > Do
Resize Linear.

Colorize > Nodes >
strength > |From: I:‘ To:

> Do Colorize.

Resize Linear > Edges >
Weight > 1 to 10 > Do
Resize Linear.

Colorize > Edges >
weight > From: I:‘ To:

> Do Colotize.

Zoom in to view cliques
& right-click to toggle
labels.
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O : Workshop Overview

9:00 Marcoscope Design and Usage & CIShell Powered Tools
9:15 Sci2 Tool Basics
» Download and run the tool.

9:30 Sci2 Workflow Design: Padgett's Florentine Families - Prepare, load, analyze,
and visualize family and business networks from 15th century Florence.

10:00 Sci2 Tool — Using Text and Database Support

»  Studying Four Major NetSci Researchers.

» Load and clean a dataset as text file or using the Sci2 Database; process raw
data into networks.

»  Find basic statistics and run various algorithms over the network.

»  Visualize the networks as either a graph or a circular hierarchy.

10:15-10:30 Break

10:30-11:00 Sci2 Research Demonstration I: Indiana Philosophy Ontology Project -
Map concepts and influence in the field of philosophy.

11:00-11:30 Sci2 Research Demonstration II: The Letters of Athanasius Kircher.

11:30-12:00 Q&A and Technical Assistance

The Letters of Athanasius Kircher — Glen Worthey

Source: http://kircher.stanford.edu/

> Kircher.csv — 362 letters and documents from Stanford’s Kircher collection
» Open Kircher.csv

IDTITLE,NAMES,OCCUPATIONS,DAY,MOUNTH,DATE,CITY,LANGUAGE,Subs

2487, Brahe @ Copernicus @ Appenzeller @ Bidermann @ Adtiansens @
Clavius,astronomer,27,June,1600,Ingolstadt,Latin,calendar @ sundials @ astronomy

2541,Gellibrand,mathematician,09,March,1635,n0 place given,Latin,longitude (@ magnetic declination @ magnetism
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The Letters of Athanasius Kircher — Glen Worthey

B R ool for L

B eitcoerheionce
Sfarch & practice

» Load Kircher.csv in “Standard csv format .
» Run ‘File > Load Generic CS1-File Into Database with the following parameters:

Core entity = LETTERS

IDTITLE=Integer

NAMES = String, Create a separate leaf table, merge if identical, contains multi-valued fields, type ‘@’ as the seperator
OCCUPATIONS = String, Create a separate leaf table, merge if identical, contains multi-valued fields, type ‘@’ as the seperator
DAY = Integer

MOUNTH = String

DATE = Integer

CITY = String, Create a separate leaf table, merge if identical

LANGUAGE = String, Create a separate leaf table, merge if identical

Subs = String, Create a separate leaf table, merge if identical, contains multi-valued fields, type ‘@’ as the seperator
These attributes can also be loaded from columnAttributes.gcl
‘U'm Finished!?
Run ‘Data Preparation > Database > General > Extract Raw Tables From Database’ to
view various database tables. 4 [ csvfile: ErSampleData\Kircher.csv

4 | Generic-C5V Database From Kircher.csv
Database Table: CITY
Database Table: LANGUAGE
Database Table: LETTERS
Database Table: LETTERS_TO_CITY
Database Table: LETTERS_TO_LANGU
Database Table: LETTERS_TO_MAMES
Database Table: LETTERS_TO_OCCUF

Y V V
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o ofcionce

‘arch & practice

» Run ‘Data Preparation > Database > Generic CS1 > Extract Co-Occurrence Network’
with the following parameters:

+ L]
Choose the Leaf column to extract the co-occurrence network on: | MAMES - e \ ¢ 1 —
. .

Mode Attributes ~ - " 1Hif /A o
[ Add Another Node Attribute Field | ONRN RN i : A

[ Remove All Node Fields ] P, \ i 2

Summarize By: Column to Summarize: Attribute Name:

iCount v] ’IDTITLE - MNumlLetters or— .‘ = . . \ g . —] :

- .
- - . . -
Edge Attributes 4 N < . i\ 5 e
[ Add Another Edge Attribute Field ] '_ % 7 i i " Y T
- * & % - f
[ Remove All Edge Fields | . oS AN ! ayea
W S
Summarize By: Column to Summarize: Attribute Name: a0 ” — ;" = L ]
[count ~| [ommE  +| [NumLetierd | [Delete ~

» Run Visualization > GUESS’ to open GUESS with file loaded.
> Apply ‘Layout > GEM followed by ‘Layout > Bin Pack’

» Results not surprising for an egocentric network.
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B R ool for L

B eitcoerheionce
Sfarch & practice

» Run ‘Data Preparation > Database > Generic CST” > Exctract Co-Occurrence Network’
with the following parameters:

* . *»
Choose the Leaf column to extract the co-occurrence network on: - el W, Y\
- L L
Mode Attributes *. .
L . S - *
[ Add Another Node Attribute Field | . " A d
- vt . o . R
[ Remove All Node Fields ] I e - LI d
. n.. LaEe =" . A
-
Summarize By: Column to Summarize: Attribute Narme: it = Tes oe N . [
- . e
[Count -] [ome - COUNT_IDTITI . e _,."' 38
. e . ... " . . T
s . .t .
. 1 * *
- b : .. .
Edge Attributes .
[ Add Another Edge Attribute Field | °
- . P— P, ot .
[ Remove All Edge Fields ] e e ot e
Summarize By: Column to Summarize: Attribute Narme: it . - . .
-
[Count ~| [ome |  countpmm A

» Run Visualization > GUESS’ to open GUESS with file loaded.
> Apply ‘Layout > GEM’ followed by ‘Layout > Bin Pack’
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Resize Linear > Edges >
edge_count_idtitle >
From 7 to 70 > Do

.
astronomical observations . .
N Resize Linear.

omy. .
edlipses £ Colorize > Edges >
universal language schemes b P

25 st . } axifat angyages edge_count_idtitle >
i etk dectination . & Systeds : From: D Ta: >

\ magnetism . e alyl hy e

i agnes, sive de arte magnetica X / Do Colorize.

I ooks — Egypt.and egyptology
R 5 i

Resize Linear > Nodes >
node_count_idtitle > 0
to 25 > Do Resize
Linear.

Object: ‘Nodes Based On’
Property:
‘node_count_idtitle’

ID: >=

Value: ‘15

Show Label
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» Run ‘Data Preparation > Database > Generic CS1” > Extract Bi-Partite Network® with
the following parameters:

Choose the Source for your bipartite network extraction: | LANGUAGE -
Choose the Target for your bipartite network extraction: | OCCUPATIONS =

MNode Attributes

[ Add Another Node Attribute Field |

[ Remove All Node Fields |

Summarize By: Column to Summarize: Attribute Narme: i

[count ~| [pmme - COUNT_IDTITI | Delete

Edge Attributes

[ Add Another Edge Attribute Field |

[ Remove All Edge Fields |

Summarize By: Column to Summarize: Attribute Name:

[Count ~| [ommE +|  COUNTIDTITI [Delete

» Run Visualization > GUESS’ to open GUESS with file loaded.
> Apply ‘Layout > GEM followed by ‘Layout > Bin Pack’
» Show labels and color nodes based on entity_type Language
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Workshop Overview

9:00 Marcoscope Design and Usage & CIShell Powered Tools
9:15 Sci2 Tool Basics
» Download and run the tool.

9:30 Sci2 Workflow Design: Padgett's Florentine Families - Prepare, load, analyze,
and visualize family and business networks from 15th century Florence.

10:00 Sci2 Tool — Using Text and Database Support
»  Studying Four Major NetSci Researcherts.

» Load and clean a dataset as text file or using the Sci2 Database; process raw
data into networks.

»  Find basic statistics and run various algorithms over the network.
»  Visualize the networks as either a graph or a circular hierarchy.
10:15-10:30 Break

10:30-11:00 Sci2 Research Demonstration I: Indiana Philosophy Ontology Project -
Map concepts and influence in the field of philosophy.

11:00-11:30 Sci2 Research Demonstration II: The Letters of Athanasius Kircher.
11:30-12:00 Q&A and Technical Assistance
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Extraneous Slides
Adding Plugins to CIShell Powered Tools

OSGi/CIShell Adoption

bg& C l Cyberinfrastructure Shell (CIShell)
A4 L http://cishell.org

» CIShell is an open soutce software specification for the integration and utilization of
datasets, algorithms, and tools.

» It extends the Open Setvices Gateway Initiative (OSGI) (http://www.osgi.org), a

standardized, component oriented, computing environment for networked services
widely used in industry since 10 years.

» Specifically, CIShell provides “sockets” into which existing and new datasets,
algorithms, and tools can be plugged using a wizard-driven process.

Developers .
6 g - Aid '%
Yoig g " 1V T,
U2 I & g

CILShel] Wizards CIShell

O
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}ggg(: I yne CIShell — Builds on OSGi Industry Standard

CIShell is built upon the Open Services Gateway Initiative (OSGi) Framework.

OSGi (http://www.osgi.org) is
» A standardized, component otiented, computing environment for networked setvices.

Successfully used in the industry from high-end servers to embedded mobile devices
since 8 years.

>
» Alliance members include IBM (Eclipse), Sun, Intel, Oracle, Motorola, NEC and many
>

others.

Widely adopted in open source realm, especially since Eclipse 3.0 that uses OSGi R4
for its plugin model.

Advantages of Using OSGi

» Any CIShell algorithm is a service that can be used in any OSGi-framework based
system.

» Using OSGi, running CIShells/tools can connected via RPC/RMI supporting peet-to-
peer sharing of data, algorithms, and computing power.

Ideally, CIShell becomes a standard for creating OSGi Services for algorithms.
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’ggg(: I yne CIShell — Converter Graph

Y

No central data format.

Y

Sci? Tool has 26 external and internal data formats and 35 converters.

Y

Their relationships can be derived by running ‘File > Converter Graph’ and
plotted as shown here. Note that some conversions are symmetrical (double

arrow) while others are one-directional (arrow).
@file:text/edge

@ file:text/nwb
@file:texttreeml+xml @®dbinsf

@ prefuse data. Tree @file textigraphml+xml
@ file:application/pajeknet
@ prefuse data.Graph @®db:any

@ file:application/pajekmat
® edu.uci.ics.jung.graph.Graph te-applcation’pajekm

® edu berkeley.guir.prefuse.graph.Graph @dbisi Pfiletextipg

@ filetext/xgmml+xml

@java.awtimage Bufferedmage

® file textbibig & 1S XYSEOPUS

®file text/grace @filetext/ps

®file:textiplat ®file:text/isi
@ prefuse.data Table

@fiteitexticsv

@ file:text/nsf

@ file:text/referbib
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CIShell — Add new Plugins, e.g., UCSD Science Map

» Not all code can be shared freely (yet).

» 'To make the UCSD Science Map and new geomaps available via the Sci? menu,

simply add
wrnerkiDeskiopiWIH-12sci2-plugins v| 0
Mame Size | Type Date Modified

edu.iu. scipalicy . visualization. geomaps_0.0.1 .jar

4,864 KB Executable Jar File 6/24/2010 5:41 PM
edu.iu.scipolicy, visualization, scimaps_0.0.1. jar 1,507 KB Executable Jar File 6/18/20103:17 PM
org.cishell.reference. gui.persistence_1.0.0.jar 61 KB Executable lar File 6/24/2010 5:41 PM
org.cishell utilities_1.0.0.jar 7Z2KB Executable Jar File 6/24/20105:41 PM

to the ‘yourdirectory/ plugin’ directory and restart the tool.

The rights to the UCSD map are owned by the Regents of UCSD. Usage does not require

a separate, signed agreement or an additional request to our office if consistent with the

permission. As a courtesy, please send information on how the map is being used to
William J. Decker, Ph.D., Associate Director, Technology Transfer Office

University of California, San Diego, 9500 Gilman Drive Dept. 0910, La Jolla, CA 92093
phone:858-822-5128, fax: 858-534-7345, e-mail: widecker@ucsd.edu

» To delete algorithms that you do not use, simply delete the corresponding *.jar files in
the plugin directory.

» Customize your menu structure accordingly—see next slide.
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CIShell — Add new Plugins, e.g., UCSD Science Map

> After you added the new plugins, load an ISI file using ‘File > Load and Clean ISI File
> BugeneGarfield.isi.”

The file can be found in the /sampledata/ scientometrics/ isi directory.

> Select ‘99 Unique ISI Records’ file in Data Manger and run “Visualization > Topical >
Science Map via Journals’ with parameters:

M Science Map via Journals @

Locate the journals from a kable on the UCSD Map of Science

Tawinel e [Journal Mame (A5b

Scaling Fackor (10 |

Dataset display name | EugeneGarfield. isi |

» The result is a science map ‘ o ‘a% a p¢ s r

overlay of Garfield’s papers |- . b @Eg :
and a listing of journals in ;- : ’ ? ANA
13 fields of science below. ‘ @ ' Foe .'I
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Cytoscape |

§2CIShell

CIShell — Add new Plugins, e.g., Cytoscape

Adding more alyout algorithms and network visualization interactivity

via Cytoscape http://www.cytoscape.org. =

Simply add org.textrend.visnalization.cytoscape_0.0.3.jar into your /plugin directory.
Restart Sci2 Tool.

Cytoscape now shows in the Visualization Menu.

File DataPreparation Preprocessing  Analysis  Modeling &)

Universitas Press)

3
E.\_C!?Diﬁ,kil .IG-eneraI i = O || 84 pata Manager|
empora =
letoscape e Etad Geospatial * Al = ] 151 Data: Cr\Dacuments and Settings|barner
(Inteqgrator(s): TexTrend Consortiom (hikp:/ /weestertrend  Motwarks b npis (TexTrend, 61 Unique ISI Records

"« Extracted Co-Authorship Network

Reference: Cytoscape Consartiurn (hitbp:/ /www.cytoscaps

Author information
CADOCUME~ 1 barnerkiLOCALS 1 TemplCIShel-Session-655524 7785800266 7991 StaticExecutable
Runner-206871827 1488870377 algorithm =echo of f

cytoscape, CytoscapeInit[INFO]: CytoscapeInit static initialization

cyboscape, CytoscapeInit[INFC]: Parent_Dir: C:\Documents and Settingsi\bornerk), cytoscape
created,

Select a network in Data Manager, run Cytoscape and the tool will start with this
network loaded.
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& Cytoscape Deskiop (New Session)
File  Edit

FEX

View Select Lawout  Plugins  Help

| control Panel [

£ Metwo L
'fg Hetwark. |VizMapper"‘ Editor || Filters

Network,

Nodes

Edges

Data Panel
0O
jis]

Munoz, Ma

————

Mode Attribute Browser | Edge Attribube Browser | Metwork Attribute Browser
oM Middle-click + drag to PAN

‘Welcome to Cyboscape 2.6.2 Right-click + drag to




& Cyioscape Deskiop (New Session)

_| Contral Panel

Fle Edit View Select Flugins  Help
E H Q @ Rotate
3 Scale

Align and Distribute Metwork

Te Metwork | vizMapper™

Settings...

Network,

J

yFiles

Attribute Circle Layout ]
Edge-weighted Spring Embedded »
Hierarchical Layouk

Circular Layout
Inverted Self-Organizing Map Layout

Group Attributes Layout »
Grid Layout
Force-Directed Layout 4

Degree Sorted Circle Layout
Spring Embedded
Edge-weighted Force directed (BioLayout) k

Data Panel

HO@

10 |

Mode Attribute Browser | Edge Attribube Browser | Metwork Attribute Browser

‘Welcome to Cyboscape 2.6.2

Right-click + drag to ZOOM Middle-click + drag to PAR

' | CIShell — Integrate New Algorithms

Algorithm Developer's Guide

Overview

The Cyberinfrastructure Shell (CIShell) is an open source, community-driven platform
for the integration and utilization of datasets, algorithms, tools, and computing
resources. algarithm integration support is built in for Java and most other programming
languages. Being Java based, it will run on almost all platforms. The software and
specification is released under an Apache 2.0 License,

This guide attempts to aid algorithm developers in creating algorithms for CIShell {and
applications built on CIShell).

This guide tries to contain all the information a new developer needs, but where
necessary, it may cite the CIShell 1.0 Specification (API) or the DSGi Service Platform
Specification, Release 4 (API}. While the guide tries to make beginning algorithm
development easier, the CIShell Specification has the last word on how the CIShell
Platfarm works.,

Table of Contents

1. CIShell Basics
2. Getting Started

. Tutorial 0: Setting Up the Development Environmeant
. Tutorial 1: Creating a Hello World Java algorithm

. Tutorial 2: Practical Java Algorithrm Development
. Tutorial 3: Integrating a Mon-lava Prograrm As An Algorithrn
. Mini-Tutorial: Integrating 3rd-party libraries
. Where to Learn More
3. Reference
1. How Algorithrms Work: & guide to algorithim plugins in C1Shell
2. Accessing the OSGi Console in CIShell tools

[y B SO T L

bttp:/ [ cishell.org/ en=DevGuide NewGuide
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gg_gc I al: CIShell — Customize Menu

> 'The file Yourtooldirectory/ configuration/ defanlt_menn.xml’ encodes the structure of
the menu system.

» In NWB Tool, the Modeling menu (left) is encoded by the following piece of

xml code:

&8 Metwork Workbench Tool
File Preprocessing [Modeling | Analysis Visuslization Scientometrics
Bl Console Random Graph
INE MEGWOTK WOTKDE  Watts-Strogatz Small World ea
irvestigatars are Dr. £ L <h
Wasserman. andDr,q  Barebsi-Albert Scale-Free
The NWE toal was de  ©*" !
Tank, Joseph Bibersti Chord ucd
Terkhorn,Heng Zhan en

Vespignani, and katy | YPerand
PRU
Netwark Warkbench ) d
Science Center thttp: TARL
<top_menu name="Modeling">
f\l‘\";:;‘}i':;ffuf;‘u‘g)wr’\ Diserete Network Dynamics (0 <menu pid=" iu. nwh.modeling. erdosrandomgraph”/>
hitp:ffnwb.dlisindial  Evaking Network (#eighted) <ment ju.nwh.modeling. smallworld" />
——————— <menL .hwh.modeling. barabasialbert" />
<menu "
<menu pid="edu.ju. jv.modeling. p2p. can.Canalgorithm" />
<menu pid="edu. ju. iv.modeling.pZp. chord.chordalgorithm” >
<menu pid="edu.id.v.modeling. p2p. hypergrid. Hypergrid" >
<menu pid="edu.fu. iv.modeling. p2p. pru. Prualgorithm” S
<menu type="hreak" />
<menu pid="edu.ju, Jv.modeling. tarl.Tarlalgorithm" />
<menu type="break"/>
<menu pid="edu.ju. nwh.modeling. discretenetworkdynamics. onoalgorithm” />
<menu type="hreak"/>
<menu pid="edu.ju. nwh.modeling. weighted. evolvingnetwork" />
</top_menu>
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CIShell/OSGi is at the core of different CIs and a total of 169 unique plugins are used in the
- Information Visualization (http://iv.slis.indiana.edu),

- Network Science (NWB Tool) (http://nwb.slis.indiana.cdu),

- Scientometrics and Science Policy (Sc¥ Tool) (http://scislis.indiana.edu), and

- Epidemics (http://epic.slis.indiana.cdu) research communities.

Most interestingly, a number of other projects recently adopted OSGi and one adopted CIShell:

Cytoscape (http:/ /www.cytoscape.org) lead by Trey Ideker, UCSD is an open soutce bioinformatics
software platform for visualizing molecular interaction networks and integrating these interactions
with gene expression profiles and other state data (Shannon et al., 2002).

Taverna Workbench (http://taverna.sourceforge.net) lead by Carol Goble, University of Manchester,
UK is a free software tool for designing and executing workflows (Hull et al., 2000). Taverna allows
users to integrate many different software tools, including over 30,000 web services.

MAEVviz (https:/ /wiki.ncsa.uiuc.edu/display/MAE/Home) managed by Shawn Hampton, NCSA is an
open-source, extensible software platform which supports seismic risk assessment based on the Mid-
America Earthquake (MAE) Center research.

TEXTrend (http:/ /www.textrend.org) lead by George Kampis, E6tvés University, Hungary develops a
framework for the easy and flexible integration, configuration, and extension of plugin-based
components in support of natural language processing (NLP), classification/mining, and graph
algorithms for the analysis of business and governmental text corpuses with an inherently temporal
component.

As the functionality of OSGi-based software frameworks improves and the number and diversity of

dataset and algorithm plugins increases, the capabilities of custom tools will expand.
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Project leader
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TEXTREND
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Tutor

TEXTREND: Development of a business and governmental decision support
toolbox using trend- and text-analysis tools

The twao interconnected objectives of the TEXTrend project are (1) the creation of
an integrated TExTrend toolkit and service basis, and (2) the elzboration of
demonstrative applications in varied fields of business and governmental
decisions, exemplified by use cases,

analysis . busipess
consartium

download dsc -
leader i network phd
i g research science
i team ... textrend
toolkit trend~ university versionweb
Created at

Team leader: George Kampis, PhD, DSc
Gydrgy Fabri, PhD, CSc

Laszld Gulyas, PhD

Sandor Sods, PhD

Zalan Szakolcei, BSc

Zoltan Szaszi, BSc

HCCI Research Institute of Economics
and Enterprises

Team leader: Istvan Janos Tdth, PhD
Aanes Czihik, M5c

Adnes Mako, MSc

Tamas Uhrin, MSc

Zoltan Varhalmi, MSc

Glia Computer Consulting Ltd.
Team leader: Attila Bencsik, MSc
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TEXTrend adds R bridge, WEKA, Wordij, CFinder, and more.

See the latest versions of TEXTrend Toolkit modules at
bttp:/ [ textrend.org/ index.php 2option=com _contentSview=articlec>id=47 &ltemid=53
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Epidemics Marketplace and EpiC Tool

Browse | Upload | Request | About

The EpiC Marketplace

ty 1o browse, request, and share epidemics uu Learn More >>

©Browse

View & Download
projects, datasets,
and requests, by
category and tags

(Upload

Upload your

(Z)Request

Can't find a dataset
you're looking for?
Make a Request!

datasets or create
a project with
multiple datasets
Location of datasets

bttp:/ [ dev.epic.slis.indiana.edy

Recent Activity
Data Requests

Heed Health Inswrance
coverage data. - Micah
Linnemejer- Indiana
University Tomanane
haws da an heakh fnzurnce
savmgs y family incoms ksl?
Thanks.

acammens.

HIV/ATDS - Tim sherman
sz dars on V.
acomman,

Data Uploads
Housing Vacancies and
Homeownership Subset
of 2008 - Jim Sherman
‘The Houzing Vacanciksand
Homeownership providescuen
infarmacion an che renczland

homsmener cancy @, ..
acommsnr.

PBehavioral Risk Farctor
swveillance system - Jin
Sherman

WRFSS: Turning Tnformarian inca
Heakh The Bohavioral Risk Faccar
Surveilance Symem (BRFSS) & che
warkds
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cyberinfrastructure for
ETVWORK SCIENCE CENTER

School of Library and Information Science | Indiana University Bloomington

Cyberinfrastructures Qutreach

All papers, maps, cyberinfrastructures, talks, press are linked
from http://cns.slis.indiana.edu
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